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 OUVERTURE ET AFFICHAGE 

Ouvrir EndNote : selon votre installation, suivre les étapes d’ouverture :  
Démarrer  Tous les programmes       EndNote  EndNote 

1.1. Créer une nouvelle base de références 

Pour créer une nouvelle base (Library) : 

1. Cliquer sur File et sélectionner New 
2. Choisir l’endroit où enregistrer la base et lui donner un nom 

 
 
 
 
 
 
 
 
 
 
 
 
 

1.2. Fermeture 

Pour fermer la base : File → Close Library 

1.3. Ouvrir une base existante 

1. Depuis l'interface d'EndNote, ouvrir le menu File et sélectionner Open Library 
Sélectionner un fichier se terminant par l’extension .enl 

2. Il est aussi possible d’ouvrir le menu File et sélectionner Open Recent Ceci fait 
apparaître la liste des dernières bases utilisées 

  

1 

2 

My Endnote Library (*.enl) 
(Nom proposé par défaut) 
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 ENVOYER UNE BASE ENDNOTE PAR EMAIL 

Si vous souhaitez envoyer votre base de données EndNote à quelqu'un, vous devrez vous 
assurer d'envoyer à la fois le fichier.enl et le dossier.data. Cela peut créer un courriel volumineux, 
et EndNote offre la possibilité de compresser les fichiers et de les enregistrer dans un seul fichier 
qui peut ensuite être envoyé par e-mail.   
 
Pour faire une copie d’une base afin de la transmettre ou de la joindre à un courriel : 
File  Compressed Library (.enlx).  
 
La bibliothèque compressée sauvegarde tous les éléments de la bibliothèque Endnote, ainsi que 
la corbeille. Il est recommandé de vider la corbeille avant d’effectuer cette opération afin de 
maintenir la taille du fichier compressé aussi petite que possible. 
Une fois la base sauvegardée dans le répertoire voulu, l’extension du nom de fichier sera .enlx. 
 

À la réouverture de cette base (double 
clic sur le fichier .enlx), le fichier .enl et 
le dossier .DATA associés seront 
recréés automatiquement.  

1 

2 
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Barre de titre (Title bar) Barre des menus (Menu bar) Barre d’outils (Toolbar) 

Fenêtre de recherche dans la 
base (Search Panel) 

 DESCRIPTION DE L’INTERFACE 

  

Barre d’état 
(Status bar) 

Fenêtre de groupes 
(Groups Panel) 

Fenêtre des références (Reference Panel) : 
• Reference : Visualisation de tous les différents champs de la 

base de données pour ce type de référence. 
• Preview : Visualisation de la référence sélectionnée selon le 

style choisi; 
• Attached PDFs : Affichage de(s) fichier(s) PDF joints à une 

référence sélectionnée. 

Layout permet de visualiser ou de cacher la fenêtre de groupes 
(Groups Panel) et d’afficher la fenêtre des références (Reference 
Panel) à droite ou en bas. 

Recherche en ligne Insérer une citation 

Import des références à partir 
des bases de données 

Formater une bibliographie 

Style choisi 
 

Nouvelle référence 
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Les intitulés des champs 
(headings) 
peuvent être personnalisés. 
 

 SÉLECTION DES COLONNES POUR L’AFFICHAGE 

Il est possible d’afficher jusqu’à 10 champs (colonnes) par référence dans la fenêtre principale. 
La configuration par défaut de EndNote X9 comprend les champs suivants : 

• Lu/Non lu 
• Fichier joint 
• Auteur 
• Année de publication 
• Titre 
• Classement (Rating) 
• Revue 
• Date de mise à jour (Last Updated) 
• Type de référence 

 

 
Pour réorganiser les champs qui s’affichent, sélectionner l’intitulé de colonne respectif avec le 
bouton gauche de la souris et le déposer à l’endroit désiré. 
 

Pour modifier le nombre de champs affichés ou encore pour modifier les champs affichés : 

• Menu  Edit > Preferences et cliquer sur Display Fields. 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

Un clic sur l’intitulé d’une colonne 
trie les références selon ce 
champ. 
 

1 

2 
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OU 

• Cliquer sur un intitulé de colonne avec le bouton droit de la souris et sélectionner les 
champs désirés. 

 

 ALIMENTATION DE LA BASE ENDNOTE 

5.1. Connexion directe 

La connexion directe permet d’importer des références provenant de catalogues de 
bibliothèques. Les fonctions de recherche sont limitées puisque l’outil combine l’interface de 
recherche EndNote et certaines fonctions du catalogue de bibliothèque interrogé. Cette 
fonctionnalité convient aux recherches simples. 
 

1. Sélectionnez Online Search Mode (Temporary Library) pour la connexion 
directe. Pour ce faire, il faut cliquer sur le globe terrestre de la barre d’outils  

2. Choisissez une connexion dans la zone Online Search 
3. Entrez les critères de recherche puis cliquer sur Search 
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4. Choisissez le nombre de résultats à importer dans Endnote 

 
Attention, lorsque vous êtes dans le mode Online Search Mode (Temporary Library), aucune 
référence n’est encore définitivement dans votre base EndNote locale. Pour enregistrer les 
références dans votre base, suivre les étapes suivantes : 

5. Sélectionnez les références que vous souhaitez conserver 
6. Cliquez sur l’icône Copy to Local Library 
7. Revenez à votre bibliothèque où vos références sont maintenant enregistrées 

  

1 

2 

3 

4 

5 

6 

7 
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5.2. Importation indirecte 

L’importation indirecte consiste à télécharger sur son ordinateur un fichier de références à partir 
d’une base de données bibliographiques, p.ex. PubMed, puis à importer ce fichier dans la base 
EndNote 
 

5.2.1. Marche à suivre pour Pubmed : 

1. Dans la liste des résultats affichées par Pubmed sous www.pubmed.gov, sélectionnez les 
références souhaitées 

2. Cliquez sur le lien Send to : 
3. Sélectionnez l’option Citation manager 
4. Cliquez sur le bouton Create File 
5. Enregistrez le fichier sur votre ordinateur 
6. Depuis EndNote : File > Import > File… 
7. Sélectionnez le fichier et choisissez PubMed 

(NLM) dans la liste déroulante Import Options 
8. Cliquez sur le bouton Import 

 

 

Si vous avez plus de 200 résultats à exporter de PubMed vers EndNote, vous devrez choisir l'option "File" sous 
"Choose destination". Le fichier résultant sera formaté en fichier.txt et peut être importé de la même manière que le 
fichier.nbib. 

http://www.pubmed.gov/
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5.3. Importation manuelle de fichiers PDF et références associées 

À partir d’un fichier PDF enregistré sur le poste de travail de l’usager, EndNote peut créer une 
nouvelle référence et lui joindre le fichier PDF respectif. Les informations bibliographiques de 
base seront ajoutées automatiquement dans la référence. 
 
Pour qu’EndNote puisse effectuer l’importation, le PDF doit comprendre un DOI (Digital Object 
Identifier). La façon dont le DOI est mentionné dans les deux premières pages du document 
détermine le succès ou l’échec de l’importation. 
 
Voici trois situations où l’importation s’exécute correctement : 
 
 

 
 
Voici les étapes à suivre : 

1. Dans EndNote : choisir File  Import  File…  ou File  Import  Folder…  
2. Sélectionner le fichier PDF à importer dans Import File: ou le dossier à importer dans 

Import Folder: 
3. À la ligne Import Option: aller chercher le filtre PDF 
4. À la ligne Duplicates choisir Import All et à Text Translation choisir No Translation. 

Cliquer sur Import 
 
Chaque référence créée aura automatiquement comme pièce jointe son fichier PDF importé 
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Dans les cas suivants, l’importation ne s’effectue pas correctement : 
 

 
 
Important ! Pour ces cas, il est possible de suivre les étapes suivantes pour retrouver les 
informations bibliographiques nécessaires. 

1. Copier et coller le DOI dans une nouvelle référence (voir point 5.4 Saisie manuelle)  
2. Sélectionner la nouvelle référence 
3. Utiliser la commande Find Reference Updates… (voir point 11) 

1 

2 

3 

4 
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4. Choisir l’option Update All Fields dans la fenêtre qui s’ouvre 

 

5.4. Saisie manuelle 

Il existe 55 formulaires prédéfinis à choisir selon le type de références. Lors de l’ajout d’une 
nouvelle référence ou lors de l’ouverture d’une référence existante, choisir ou modifier le type 
de référence (Reference type) pour accéder au formulaire correspondant. 
 

1 

2 

3 

4 
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Le type de formulaire choisi doit correspondre au type de référence que l’on veut 
intégrer dans la base. (voir 6 Types de références) 
Pour saisir manuellement les références : 

1. Choisir References  New Reference ou cliquer sur l’icône de la barre d’outils 
2. Choisir le bordereau représentant le type de document correspondant à la publication 
3. Compléter les champs en respectant les recommandations de saisie 
4. Sauvegarder en cliquant sur le X et sur « Yes » dans la boîte de dialogue qui s’ouvrira 

 
  

2 

3 

4 1 
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 TYPES DE RÉFÉRENCES 

Le tableau suivant représente les types de documents les plus fréquents et les types de 
références correspondants recommandés. 

 

 RÉFÉRENCES 

Une référence comporte jusqu’à 52 champs dont certains peuvent être personnalisés selon vos 
besoins. 
Les données d'une référence devraient contenir les informations permettant de citer le document 
selon le style désiré. 
 

 
  

Types de documents Type de référence dans EndNote 

Article de revue académique imprimé ou électronique Journal Article 
Article d’encyclopédie ou de dictionnaire  Encyclopedia 
Brevet Patent 
Communication à une conférence Conference Proceedings 
Livre, dictionnaire ou encyclopédie (imprimé) Book 

Edited Book 
Livre en format électronique Electronic Book 
Chapitre de livre, chapitre d'aide-mémoire  Book Section 
Chapitre de livre, chapitre d'aide-mémoire en format 
électronique 

Electronic Book Section 

Norme Standard 
Mémoire de maîtrise ou thèse de doctorat Thesis 
Rapport technique ou gouvernemental Report 
Site Web ou page Web Web Page 

Vous pouvez choisir 
d’afficher (Show Empty 
Fields) ou de cacher les 
champs vides. 
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7.1. Ouvrir une référence 

Pour ouvrir une référence, EndNote X9 vous propose deux options : 

• Double-cliquer sur la référence voulue pour l’ouvrir en plein écran 

OU 

• Sélectionner la référence et cliquer sur l’onglet « Reference » 

Les dimensions des différentes fenêtres peuvent être ajustées pour avoir un affichage 
convenable. 
 

 
  

2 

1 
Double-clic 
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 STYLES 

Dans une base, un clic sur une référence permet de la visualiser dans l’onglet Preview selon le 
style choisi.  
 

 
 
La commande Select Another Style… permet de sélectionner un 
style parmi les styles disponibles sur votre poste. 
 
Pour accéder à tous les styles offerts par EndNote vous pouvez 

•  Consulter le site https://endnote.com/downloads/styles/  
•  Aller sur Help  EndNote Output Styles… 

 
  

1 

2 

https://endnote.com/downloads/styles/
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8.1. Chercher un style dans le répertoire du site EndNote 

La recherche de styles dans le répertoire officiel d’EndNote peut se faire en combinant plusieurs 
critères de recherche. Ceci permet de filtrer les résultats parmi les très nombreux styles 
disponibles. 
 

 

8.2. Installer un nouveau style 

Pour installer un nouveau style dans le logiciel EndNote : 

1. Télécharger le style trouvé à l’étape précédente 
2. Double-cliquer sur le fichier nom_du_style.ens (extension .ens) téléchargé sur le poste 
3. Le style s’ouvre dans EndNote. Cliquer sur File  Save As 
4. Supprimer la mention Copy après le nom du style et cliquer sur Save 
5. Finalement, cliquer sur File  Close Style 
6. Le style est maintenant dans la liste des styles disponibles (Voir point 8  commande 

Select Another Style) 

1 
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2, 3 

4 

5 
6 
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8.3. Editer un style 

Si le rendu du style ne correspond pas exactement à ce qui est demandé, vous pouvez modifier 
un style existant. 
 

1. Choisir Edit → Output Styles → Open Style Manager 
 

 
2. L'éditeur de style s'ouvrira et vous pourrez faire les changements dont vous avez besoin. 

 
Exemples 
 
Pour modifier l'affichage des citations dans le texte 

 
 

1 
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Pour modifier l'affichage des citations dans votre bibliographie 
 

• Pour modifier le format - surligner le texte et utiliser les boutons de formatage au-dessus 
de la fenêtre Citations In-Text 

• Pour modifier la ponctuation - taper ou supprimer des signes de ponctuation selon les 
besoins. 

En plus des aspects ci-dessus, il existe des caractères spéciaux ou "fields" avec lesquels 
EndNote contrôle la façon dont les notices apparaissent dans la bibliographie. Placez votre 
curseur à l'endroit où vous voulez placer le caractère dans le modèle. Allez dans "Insert Field" à 
droite et sélectionnez le caractère approprié : 
 
• Singulier/pluriel (^ symbole) - utilisé s'il y a du texte différent pour les formes singulières ou 

plurielles, par exemple (Ed.),^(Eds.) 
• Lier le texte adjacent - un espace incassable (représenté par un petit losange gris dans le 

modèle) utilisé pour lier le texte adjacent à un champ afin que le texte n'apparaisse pas si le 
champ est vide. 

• Séparation forcée (| symbole de barre) - utilisé pour séparer la ponctuation des champs 
adjacents. Par exemple, vous pouvez vouloir un point à la fin, peu importe les champs 
vides. 

• Noms des champs sous forme de texte littéral (`accent grave) - utilisé si vous voulez du 
texte dans vos références qui a déjà été utilisé comme nom de champ, par exemple si vous 
voulez le mot 'année' ainsi que le champ année. 

• Pour supprimer un champ - Surligner → cliquez sur 'Delete' sur votre clavier. 
• Pour substituer des champs, sélectionnez Bibliographie → Field Substitutions et cochez les 

cases appropriées, par exemple le champ URL peut être inséré pour les notices sans DOI. 
 

N'oubliez pas de sauvegarder vos modifications en tant que copie. Testez vos 
modifications dans un document Word de test. 
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 OUTILS POUR GÉRER VOTRE BASE 

9.1. Création d’un groupe 

Jusqu’à 5000 groupes de références peuvent être créés à l’intérieur d’une même base. 

1. Cliquer sur Groups 
2. Sélectionner Create Group 
3. Nommer votre groupe 

 
 

9.2. Création de « Smart Group »  

La fonction « Smart Group » correspond à des critères de 
recherche (stratégies de recherche) permettant de mettre à 
jour automatiquement des groupes lors de l’importation ou de 
la mise à jour des références. 

1. Cliquer sur Groups 
2. Sélectionner Create Smart Group 
3. Inscrire le nom du « Smart Group » 
4. Entrer les critères de recherche 
5. Cliquer sur Create 

  

1 
2 

3 

1 

2 

Un groupe ne fait que pointer 
vers un sous-ensemble de 
références déjà présentes 
dans la base. 
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9.3. Création d’un ensemble de groupes 

Pour créer un ensemble de groupes : 

1. Cliquer sur Groups 
2. Sélectionner Create Group Set 
3. Nommer l’ensemble de groupes 
4. Glisser dans le « Groupe Set » les groupes à rassembler. 

 

  

3 

4 

5 

1 

2 
 

3 

4 
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9.4. Supprimer des références 

Quand une référence est supprimée, elle est automatiquement envoyée dans la corbeille (Trash). 

1. Sélectionner la (les) référence(s) à supprimer 
2. Cliquer sur l’onglet References 
3. Choisir Move References to Trash 
4. Pour vider la corbeille, choisir References  Empty Trash 

 

9.5. Vérification des références 

Après une importation de références provenant d’une ou de plusieurs bases de données, vérifiez-
les afin de vous assurer que les informations importées sont complètes et qu’elles ont bel et bien 
été importées dans les bons champs. Ne pas oublier de retirer les doublons (voir aussi 10. 
Dédoublonnage). 
 

9.6. Correction d’une référence ou correction en lot 

Pour corriger une référence : 

1. Ouvrir la référence afin de l’éditer en plein écran (double-clic sur la référence) ou bien dans 
l’onglet « Reference » 

2. Lorsque les corrections sont faites, sauvegarder en cliquant sur le X de la fenêtre en mode 
plein écran ou en cliquant sur une autre notice en mode « Reference » 

3. Choisir « Yes » dans la boîte de dialogue 

Pour la correction en lot :  

1. Sélectionner les références à corriger 
2. Afficher ces références avec References  Show Selected References  
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Ensuite, deux options sont 
possibles pour effectuer des 
changements dans ces 
références : 
 
 
 
 
 
 
 

9.6.1. Option A : « Find and Replace… » 

Pour chercher une chaîne de caractères en particulier et la remplacer par une autre. 

3. Poursuivre avec Edit  Find and Replace…   
4. Dans la liste Select a field…, choisir le champ où effectuer des corrections. 
5. Inscrire le texte à changer dans la boîte Find: 
6. Inscrire le texte de remplacement dans Replace with:, puis cliquer sur Change 

  

1 

2 

3 

4 

5 

6 
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9.6.2. Option B : « Change/Move/Copy Fields… » 

Pour modifier un champ pour toutes les références sélectionnées. Par exemple, afin de bien 
organiser sa base, il est possible d’utiliser cette fonction dès l’ajout de nouvelles références pour 
inscrire le nom de la base de données depuis laquelle proviennent les notices et la date à laquelle 
elles ont été ajoutées. 

3. Poursuivre avec Tools  Change/Move/Copy Fields… 
4. Dans la liste Select a field…, choisir le champ où effectuer des corrections 
5. Choisir le type de modification à appliquer et inscrire le texte à insérer dans la fenêtre de 

droite 
6. Cliquer sur OK 

  

3 

4 
 

5 
 

6 
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 SUPPRIMER LES DOUBLONS (« DÉDOUBLONNAGE ») 

EndNote X9 vous permet d’identifier les doublons (références à doubles) de votre base et de 
comparer leur contenu afin de choisir la meilleure version de la référence à conserver. 
 
Par défaut, les doublons sont repérés en comparant les champs « Author », « Year », « Title » 
et « Reference Type ». 
 
Vous avez la possibilité de comparer différents champs de la base de données afin de 
déterminer si les références sont réellement des doublons. Il peut être utile de comparer les 
champs « Title » and « Year » puisque par exemple, les noms des auteurs pourraient être 
écrits différemment. 
 
Pour modifier les paramètres de comparaison : 

1. Cliquer sur Edit  Preferences 
2. Sélectionner Duplicates 
3. Décocher les champs « Author » et « Reference Type » 

 
Puis, pour comparer les doublons : 

4. Cliquer sur References  Find Duplicates 
5. Comparer le contenu des deux références et choisir la référence préférée 
6. Au besoin, faire les modifications nécessaires dans la notice à conserver. Par exemple, 

vous pourriez copier-coller d’une notice à l’autre un DOI dans la notice à conserver où il 
n’était pas présent, mais qui contenait déjà un ISSN et une adresse URL. 

1 
2 

3 
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7. Cliquer sur Keep This Record de la notice à conserver 

 
Si vous avez un grand nombre de références à dédoublonner, vous pouvez également vérifier 
les doublons sous la forme d'une liste. 
 
Dans ce cas vous pouvez cliquer sur « cancel » dans le fenêtre ci-dessus et les doublons 
s'affichent comme une liste où toutes les références à double sont marquées en bleu. Avec la 
barre de défilement à droite, vous pouvez vérifier s'il n'y a pas de faux doubles, et tout en 
maintenant la touche CTRL de votre clavier enfoncée, vous pouvez désélectionner toutes les 
références que vous ne voulez pas supprimer. 
 

 
Si vous avez vérifié que seuls les vrais doublons sont sélectionnés, vous pouvez cliquer sur 
« Delete » sur votre clavier pour supprimer tous les doublons simultanément. 
  

4 

5, 6 

7 
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 QUELQUES FONCTIONNALITÉS DE RECHERCHE DANS VOTRE BASE 

ENDNOTE 

Il est possible de choisir tous les champs ou un champ spécifique où exécuter une recherche. Il 
vous suffit d’utiliser la fenêtre supérieure de l’écran principal et sélectionner l’onglet Search ou la 
commande Tools  Search Library… 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
La recherche s’effectue dans toute la base à moins d’avoir préalablement sélectionné certaines 
références. 
 
Match Case : lors de la recherche, la casse des caractères (minuscules et majuscules) est 
considérée (p.ex : une recherche sur le terme 3d ne repérera pas 3D).  
 
Match Words : recherche les mots exacts (p.ex : une recherche sur le terme position ne repérera 
pas positioning). 
 
Note : Par défaut, la troncature est appliquée à gauche et à droite du terme de recherche. 
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 TROUVER LES MISES À JOUR DES RÉFÉRENCES 

La commande Find Reference Updates peut trouver des mises à jour pour une référence ou 
plusieurs sélectionnées en même temps. Les informations additionnelles détectées sont 
présentées dans la fenêtre Review Available Updates for Reference… 
 

Pour mettre à jour une ou plusieurs références : 

1. Ouvrir la référence ou sélectionner la ou les références à mettre à jour 
2. Faire References  Find Reference Updates… pour ouvrir la boîte de dialogue Review 

Available Updates for Reference… 
3. Toutes les mises à jour sont surlignées en bleu dans Available Updates et My Reference. 

Pour les mises à jour trouvées pour une notice, les options Update All Fields, Update 
Empty Fields et Edit Reference sont disponibles. Update All Fields va copier tous les 
champs de la mise à jour dans la référence initiale et Update Empty Fields va copier les 
informations supplémentaires seulement dans les champs vides de la référence initiale. 
Les mises à jour peuvent aussi être copiées et collées un champ à la fois de la colonne 
Available Updates dans les champs respectifs de la notice My Reference en 
sélectionnant Edit Reference 

4. Sauvegarder en cliquant sur Save and Continue et OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

1 
2 

3 

4 
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 METTRE À JOUR LES TITRES DE REVUES 

Certaines bases de données bibliographiques importent uniquement les titres abrégés des 
revues alors que le style de citation utilisé peut parfois nécessiter le nom de la revue en entier, et 
vice versa. 
 
EndNote met à disposition une liste des noms de revues et leurs différentes abbréviations de 
façon à ce qu’il soit possible d’utiliser l’une ou l’autre variante dans sa bibliographie correctement. 
 
Pour mettre à jour la liste des titres de revues disponibles, voici les étapes à suivre. Il est 
recommandé de le faire systématiquement avant de créer votre bibliographie dans Word : 

1. Aller dans Tools  Open Term Lists  Journals Term List 
 
 
2. Dans la fenêtre qui s’ouvre, choisir 
l’onglet Lists et sélectionner Journals 
3. Sélectionner Delete List… et accepter le 
message d’avertissement en cliquant sur 
OK. La liste Journals a maintenant disparu 
 
 
 

4. Sélectionner Create List…, lui donner le nom 
Journals, cocher la case  Journal List et 
cliquer sur OK 

  

1 2 

3 

4 
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5. Sélectionner ensuite la liste Journals nouvellement créée 
6. Cliquer sur Import List 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

7. Sélectionnner la liste souhaitée en fonction du domaine d’activité. Dans notre cas il s’agit 
de la liste Medical.txt et cliquer sur Ouvrir. La liste des titres de revues est maintenant à 
jour  

5 

6 

7 



30 

 VISITER L’ADRESSE INTERNET PRÉSENTE DANS LE CHAMP URL 

D’UNE RÉFÉRENCE 

1. Sélectionner la référence ciblée  
2. Cliquer sur l’icône Open Link dans la barre d’outils 

 
OU  

Sélectionner la référence  cliquer sur le bouton droit de la souris  URL  Open URL. 

 JOINDRE DES FICHIERS À UNE RÉFÉRENCE 

EndNote offre la possibilité de joindre des fichiers à une référence. Par exemple, le texte intégral 
des articles en format PDF, des fichiers texte et des images peuvent être joints à une notice. 

1. Sélectionner la référence ciblée et cliquer sur le bouton droit de la souris 
2. Dans le menu contextuel, choisir File Attachments  Attach File… 
3. Sélectionner le fichier respectif et cliquer sur Ouvrir 

OU 

1. Double-cliquer sur la référence ciblée pour l’ouvrir 
2. Glisser – déposer le fichier à joindre dans la référence 

OU 

1. Double-cliquer sur la référence ciblée pour l’ouvrir 
2. Cliquer sur l’icône du trombone 
3. Sélectionner le fichier respectif 

 
 
 
Pour conserver dans votre base des copies de tous vos fichiers PDF joints aux références dans 
le sous-dossier .PDF du dossier .DATA : 

1. Edit  Preferences  
2. Sélectionner URLs & Links 
3. Sélectionner Copy new file attachments to the default file attachment folder and 

create a relative link et cliquer sur OK 
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Si vous voulez simplement avoir un lien vers la localisation sur votre ordinateur du fichier PDF 
joint et non une copie intégrée dans la base EndNote : 

3. Décocher Copy new file attachments to the default file attachment folder and create 
a relative link et cliquer sur OK 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 ANNOTER LES FICHIERS PDF JOINTS À UNE RÉFÉRENCE 

Sous EndNote X9, il est possible de visionner et d’annoter les fichiers PDF joints aux 
références sous l’onglet « Attached PDFs ». 
 
La barre d’outils sous cet onglet (PDF Viewer Panel) comprend entre autres Highlight Text 
(surligner le texte), Sticky Note (ajouter un commentaire) et Find (rechercher un terme ou une 
expression dans le texte du PDF affiché). 
 
  

1 

2 3 

Barre d’outils PDF Commentaire 
(Sticky Note) Surligner 

(Highlight Text) 
Rechercher 

(Find) 
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16.1. Pour ajouter un commentaire : 

1. Sélectionner Sticky Note sur la barre d’outils de l’onglet « Attached PDFs » 
2. Placer le curseur dans le texte du PDF à l’endroit où insérer le commentaire et cliquer. (Si 

désiré, sélectionner le texte et le surligner avec Highlight Text avant de cliquer sur Sticky 
Note.) 

3. Saisir l’annotation dans la petite fenêtre qui apparaît 
4. Cliquer sur Save PDF ou fermer la petite fenêtre et enregistrer le commentaire 

 

16.2. Pour surligner du texte 

Pour surligner en jaune une partie du texte, la sélectionner et cliquer sur Highlight Text.  
 
Pour éliminer le marquage du texte, le sélectionner puis cliquer avec le bouton droit de la souris 
et choisir Delete Annotation.  
  

1 

2 

3 

4 
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 PRODUCTION AUTOMATIQUE D’UNE BIBLIOGRAPHIE 

17.1. Insérer une citation dans un document Word 

Ouvrez Word et sélectionnez l’onglet EndNote X9 dans le bandeau de Word. 

 

 

1. Dans votre base EndNote, sélectionner la référence à ajouter dans votre document Word 
2. Dans le texte de votre document Word, positionner votre curseur à l’endroit de la citation 
3. Sélectionner l’onglet EndNote X9, puis cliquer sur la loupe Insert Citation et choisir Insert 

Selected Citation(s) 
4. La référence s’insère alors dans le texte à l’endroit où se trouve le curseur selon le style 

choisi et une liste de références (ou bibliographie) se crée à la fin du texte 

 
 

 
 

Attention : le fichier Word et votre base EndNote doivent 
être ouverts simultanément. 

1 
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17.2. Générer une bibliographie indépendante à partir de 
références de votre base EndNote 

Dans EndNote : 

1. Sélectionner les références désirées 
2. Afficher ces références avec References  Show Selected References 

2 

4 

3 
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3. Choisir Edit  Copy Formatted 

 
Dans Word : 

4. Cliquer sur Accueil et choisir Coller. Les références s’afficheront dans le style 
bibliographique choisi 

 
 
Ou 
 
 
 
Dans EndNote : 

1. Sélectionner les références 
2. Afficher ces références avec References  Show Selected References 
3. Faire File  Export…, choisir le type de fichier et le style bibliographique et enregistrer 

le fichier  

1 

2 

3 

4 
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17.3. Apporter une modification à une citation 

1. Dans le texte, sélectionner la citation où la modification doit être faite. Elle apparaîtra 
surlignée en gris 

2. Cliquer sur l’onglet EndNote X9 dans la barre des menus, puis sélectionner Edit & 
Manage Citation(s) 

3. Choisir la modification à apporter parmi les possibilités suivantes : Edit Library 
Reference (corriger une faute présente dans la référence EndNote), Find Reference 
Updates… (rapatrier les mises à jour pour cette référence), Remove Citation 
(supprimer l’appel de citation dans le texte), Insert Citation (ajouter une référence 
supplémentaire à cet appel de citation), Update from My Library (rapatrier les 
corrections apportées à la référence dans la bibliothèque EndNote) 

4. Faire OK pour sauvegarder 

1 

2 

3 
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17.4. Personnaliser votre bibliographie 

1. Dans la barre EndNote, cliquer sur la flèche de la section Bibliography   
2. Choisir le style approprié sous With 

output style: 
3. Sous l’onglet Layout, ajouter l’intitulé de 

cette liste de références.  
Ex. : Bibliographie 

 
 
 
 
 
 
 
 
 
 
 
 
 
Créer une bibliographie pour chaque chapitre ou section d’un document 

1. Sélectionner Edit  Output Styles  Edit "nom du style choisi" 
2. Cliquer sur Sections 
3. Choisir une des options suivantes : 

a. Créer une bibliographie complète à la fin du document 
b. Créer une bibliographie pour chaque section 
c. Créer une bibliographie pour chaque section et une bibliographie complète à la fin 

du document 
4. Enregistrer les changements à la fermeture du style 

 
 
 
 
 
 
 
 
 
 
 
 
 

1 

2 3 
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 TYPES DE FICHIERS 

Le tableau suivant présente les principales extensions des fichiers inclus dans EndNote. 
 

  

                                            
1 Les filtres .enf permettent d’importer des références téléchargées depuis une base de données. Par exemple le filtre PubMed (NLM).enf 
disponible par défaut dans EndNote permet l’import depuis Pubmed. 
 
2 Il existe des modèles Word, accessibles depuis le menu « Tools  Manuscript Templates » d’EndNote et qui permettent de préparer un 
document pour le soumettre à une revue en particulier (e.g. BMJ.dotm) 

Base de données : nom.enl Ex. : Demo.enl  Voir chapitre 1.3  
Base de données : nom.enlx 
L’extension .enlx indique que les données et les 
index sont comprimés dans un seul dossier. 

Ex. : Demo.enlx Voir chapitre 2 

Index + fichiers images : nom.Data Ex. : Demo.Data Voir chapitre 2 
Styles bibliographiques : nom.ens Ex. : APA 6th_fr_EPM.ens Voir chapitre 8.2 
Filtres d’importation : nom.enf1 Ex. : PubMed (NLM).enf  
Gabarits pour rédaction avec Word : nom.dotm2 Ex. : BMJ.dotm  
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